Toon Boom Studio 8
New Features Guide



Toon Boom Studio 8 New Features

Legal Notices

Toon Boom Animation Inc.
4200 Saint-Laurent, Suite 1020
Montreal, Quebec, Canada
H2W 2R2

Tel: +1 514 278 8666
Fax: +1 514 278 2666

toonboom.com
Disclaimer

The content of this guide is covered by a specific limited warranty and exclusions and limit of liability under the
applicable License Agreement as supplemented by the special terms and conditions for Adobe®Flash® File
Format (SWF). For details, refer to the License Agreement and to those special terms and conditions.

The content of this guide is the property of Toon Boom Animation Inc. and is copyrighted.
Any reproduction in whole or in part is strictly prohibited.
Trademarks

Toon Boom Studio® is a registered trademark, and the Toon Boom logo are trademarks of Toon Boom
Animation Inc.

Credits

Art Development: Shabana Ali, Marie-Eve Chartrand, Tania Gray, Anouk Whissell

Technical Editor: Peter Cawthorne, Pamela Grimaud, Liven Tam

Technical Reviewer: Gabriel Bouchard, Virginie Filion, John Payne, Natalia Solari, Jacques Tremblay

Technical Writer: Shabana Ali, Marie-Eve Chartrand, Christopher Diaz, Annie Rodrigue, Liven Tam, Phoebe
Wang-Chao, Anouk Whissell

Publication Date
2013-09-09
Copyright © 2013 Toon Boom Animation Inc., a Corus® Entertainment Inc. company. All rights reserved.

PNFG101TBS8EN


http://www.toonboom.com/

Toon Boom Studio 8 New Features Guide Contents

Contents

Toon Boom Studio 8 New Features Guide ... ... . .. ... 1
Legal Notices _ ... 2
CONtENES e 3
INtrodUCtioN 4
INstant MotioN e 5
Instant Motion Properties .. .. .. 7
Orienting Animation on a Path . . 7
Natural MoVemMENt .. 9
Previewing Effects .. il 11
Blockbuster Effects . ... . . 15
Shatter Effects .. ..o 16
Magic B eCts . 18
EXPlosion Effects .. 19
Splash EffeCts _ ... . 19
Fire B Cts il 20
Celestial Effects .. ... 21
DSy N C VW e e et il 22
Creating a Lip-sync Using a Mouth Template ... ... 22
Creating a Lip-Sync Using Your Own Drawings . ... ... i 24
Working with Scenes and Transitions .. il 26
About the Storyline View ... 26
Playing @ SequUeNCe ... 26
Applying TransitioNS . ... 27

T AN ONS . e 28
Fade oL 28
Wi 29
Sl 29
Clock Wi il 29
CheCKer . 30
Cross DissolVe . .. 30



Toon Boom Studio 8 New Features

Introduction

Toon Boom Studio 8 has a series of shining new features! If you are already familiar with Studio, you can simply
read this document to learn all about the new features.

This guide is divided as follows:
¢ Instant Motion on the facing page

¢ Natural Movement on page 9

e Previewing Effects on page 11

¢ Blockbuster Effects on page 15

¢ Lip-syncView on page 22

¢ Working with Scenes and Transitions on page 26
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Instant Motion

With Instant Motion, creating animation could not be easier. First, you create a drawing and then you translate,
scale, or rotate it. As you manipulate your drawing, small dots are created, representing keyframes. The slower
the movement, the more dots are created.

Once you release the pointer, your animation is created. It is represented on the Timeline view as a path. Your
animation can be as long or as short as you like. As you continue to move your drawing, by default, the path is
automatically extended. You can create more motion paths, one after the other. Each one is automatically
added to the end of the last one.
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To create instant motion:

1. Create a drawing.
2. Inthe Animation toolbar, click the Instant Motion button.

A bounding box with control points and a rotation handle appear around your drawing, and the Instant
Motion box opens.

Control points Instant Motion @

Capture Speed: | 100 =

Auto Extend Drawing Exposure

Rotation handle

3. Do one of the following to animate your drawing (only one single transformation type is possible per
motion recording):

» Translate: To move the drawing, position the pointer over your drawing and drag it to a new location
on the screen.
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Translate pointer

» Scale: Position the pointer at one of the bounding box points, and drag to scale your drawing.

=

Scale pointer

» Rotate: Position the pointer on the rotation handle or rotation point at a corner of your drawing.
Drag to rotate the drawing.

Rotation handle Rotation point

As you translate, scale, or rotate your drawing, small dots are created to represent the keyframes of your
animation. When you release the pointer, the speed path of your animation is recorded.

=0 &= 4 = - 10 20
49 Fish .
45 Drawing
=~ (* Camera-P
& Camera
4. Click the Play g | button to view your animation.
- )
5. If youwant to combine different motions such as a rotation and a scale, you can record the motions
separately using parented pegs. The first peg can be used for the rotation and the second one for the
scale. In the Timeline view, select your drawing layer and click on the Add Parent Peg button to attach a
peg to it. Select that peg and move it around with the Instant Motion tool like you did previously for your
drawing layer. You can add as many parented pegs as you want to decompose your motions. It is always
better to have the main translation (trajectory) as the top parent peg to avoid a conflict with rotation and
scaling motion that you affect your entire trajectory rather than the drawing only.
Timeline [Scene-2] - [Frame 1] x | Exposure Sheet [Scene-2] x I Function Editor x I Storyline
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If you want to change a section of your animation once it is recorded, you can move the Timeline
playhead to the frame where you want to start overriding the exiting keyframes with a new recording
and move your drawing again using the Instant Motion tool.

Instant Motion Properties

The Instant Motion box lets you set the speed at which keyframes are created (the capture speed) and decide if
you want to automatically extend the drawing exposure. By default, drawing movements are always recorded.

Instant Maticn @

Capture Speed: | 100 (=

| Auto Extend Drawing Exposure

e Capture Speed: The speed at which keyframes are created as you manipulate your drawing. The default
value is 100. The higher the number, the faster movement recording occurs in the viewer, as indicated by
the numbers of dots in the viewer.

e Auto Extend Drawing Exposure: By default, this option is on. This option automatically extends the
drawing exposure. This means you do not have to extend your existing drawings once the motion is
created.

Orienting Animation on a Path

Once you have created your animation, you can orient the drawing to the motion path. The Orient to Path
option is available in the Properties view.

In this example, the default setting shows the fish keeping its original orientation throughout the motion path.
However, when the Orient to Path option is enabled, the fish follows the motion path.

e =
= Q

Disabled Enabled
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To orient your animation on a path:

1. Create a drawing.

2. Use Instant Motion to create the motion path.

3. Inthe Properties view, select the Orient to Path option.

Make sure to create your animation using Instant Motion before selecting the Orient to Path option.
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Natural Movement

Using the Natural Movement tools, you can easily animate smooth and natural actions. The Natural Movement
Forward and Natural Movement Inverse tools let you to rotate the parent bone and the rest of the children in the
chain will follow the main movement and also rotate on their own to create fluid motions. Without these little
additional rotations, the movement can be stiff and you will have to rotate the children bones on your own to
smooth out the movement and make it flow naturally.

There are two natural movement tools:

¢ Natural Movement Inverse

The Natural Movement Inverse "'\'\ tool rotates the children bones in the opposite direction from the

parent. Therefore, if you rotate the upper arm of a character upward, the forearm and hand also rotate
downward.This provides an illusion resistance in the motion as if gravity or air pressure were delaying the
rotation of the limbs. This animation principle is called follow through. If you animate a flower bending in
the wind, you will use the Natural Movement Inverse tool.
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e Natural Movement Forward

The Natural Movement Forward *m tool rotates the children bones in the same direction as the parent.

Therefore, if you rotate the upper arm of a character upward, the forearm and hand also rotate upward.
There is no illusion of resistance in this motion. The arm is deliberately bending.

To use the Natural Movement Inverse and Forward:

1. Inthe Bones Tools toolbar, select the Natural Movement Forward *# or Natural Movement Inverse 3

tool. You can also access these tools by selecting Tools > Bone Tools > Natural Movement Forward or
Natural Movement Inverse.
2. Inthe Camera view, click the bone you want to animate and rotate it.

3. Totoggle between the Natural Movement Forward and Natural Movement Inverse, hold down [Alt]
before you start the motion to select the opposite tool.

10
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Previewing Effects

To see the final look of some of your effects such as the blur, the system needs to calculate and render them. The
Camera view shows a simple version of your effects so you can play back your animation quickly. Therefore, to
see your final effects as you adjust them, you need the Effect Preview view which gives you the ability to render

the current frame and display it in a window.

Toon Boom Studio will keep in memory 200MB of rendered images. (~25 frames in HD, ~100 is half
HD and ~400 in quarter HD).

To open the Effect Preview view:

1. Select Window > Effect Preview.
2. Grab the floating view and dock it beside your Camera view.

'I EffectPreven X |KolowPalette X | Propertes X | Lbrary x |
|

» BE)

Ho Preview Avalable
- || [Render Sngle Frame || Quarter Size (160 x 90) [=] [¥] Syne Current Frame
BREDE « ol
Pen X | Text % | cets g

Tmeine [Scene-1] - [Frame 52] X | ExposwraShest X | Function Editor X | storyine x L
0 @8 a @ 5% L : cbl'lT"T |

The Effect Preview view allows you to render a single frame, a frame range or your whole scene to see your
effects. You can render the images to a quarter, half or full size of your project depending on how much memory

you want to use.
To preview a blur effect:

1. Inthe Special Effects toolbar, click the Blur Effect G "| button.

2. Inthe Timeline view, parent the drawing layers that you want to blur to the Blur effect.

11
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(2] [ emectrenen X | CokurPaistie X | Properses X | Lbeary. =

o e Avalable

3. Inthe Effect Preview view, click Render Single Frame.

The current frame preview appears at a quarter of the project's size.

EffectPreview X | ColowrPalette X | Propertes X | Lbrary x |

[ [Render Single Frame v] Quarter Size (160 % 90) [=] [¥] Sync Current Frame

4. For a better quality render, in the Size list, select Half Size or Full Size.

Render Single Frame |+ Quarter Size {160 x 90) : Sync Current Frame
Quarter Size {160 x 90)
Half Size (320 x 130
Pen X | Text Full Size (640 x 360) < b3
| |

5. Click Render Single Frame to update the preview.

12
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EffectPrevies X | Coourpalette X | Propertes X | Libeary x|

Render Sngle Frape = Fulsize (590 x 3%60)  [=] [9] $yne Current Frame

6. Inthe Properties view, increase the Radius value.

Radial P

Radius ° Ilg 76.8
Angle | | 1]
® &

7. Inthe Effect Preview view, click Render Single Frame.

EffectPreview X | ColourPalette X | Propertes % | Libeary x

Ful Sze (590 % 360) [ [¥] Sync Current Frame

8. Inthe Render drop-down menu, select Render Playback Range to render your whole scene or the
playback range section, if you customized it. Select Render from Current Frame if you want to render all
the frames starting from the current frame.

Render Playback Rand .
N

Render Single Frame

4 v Render Playback Range
Render from CHrrent Frame

Clear (22% used)

9. Once you have rendered a range of images, you can play them back by pressing the Play ty button in the

Interactive Playback toolbar (Top toolbar on Mac OS X). If you want to play back your scene without

13
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10.

11.

playing back the rendered frames, deselect the Sync Current Frame option. This will allow you to play
back only the Camera view and leave the Effect Preview window at the current frame. To play back your
rendered frames, select the Sync Current Frame option.

Once you have rendered a range of images, you can play them back by pressing the Play| g | button in the

Interactive Playback toolbar (Top toolbar on Mac OS X). If you want to play back your scene without
playing back the rendered frames, deselect the Sync Current Frame option. This will allow you to play
back only the Camera view and leave the Effect Preview window at the current frame. To play back your
rendered frames, select the Sync Current Frame option.

From the Render drop-down menu, select Clear if you want to delete the previously rendered frames to
clear some memory. Toon Boom Studio will keep up to 200MB of images in memory. If the rendering
buffer is full, select this option to empty it.

14
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Blockbuster Effects

The Toon Boom Studio Blockbuster effects allow you to add some glamour and bang to your animation!

This section is divided as follows:

Shatter Effects on the next page

Magic Effects
Explosion Effects on page 19

Splash Effects on page 19
Fire Effects on page 20

Celestial Effects on page 21

To add a Blockbuster effect:

1.

In the Special Effect toolbar, click the Blockbuster Effect ;;,@"- button.

A Blockbuster effect layer, as well as its child, a Sprite-Drawings layer, is added to the Timeline view. A
sprite is the particle multiplied and generated by the Blockbuster effect. In the example below, a drawing
of a brick is used as the sprite.

O #= & | 5=
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Q@ Sprite-Drawings
45 Drawing
=~ Camera-P
& Camera
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By default, the brick wall shatter effect is selected and visible in the Camera view.

You have the possibility to create your own effect and customize it as you want. Create your own particle
on a drawing layer, or import an image to use as a sprite (particle to multiply in the effect). Then you can
attach that drawing to the existing Blockbuster effect and it will override the default content.

In the case of the Blockbuster Shatter effects, the first image will be used as the image to break to pieces
and the second drawing will be used as the pieces and area to break in the first drawing—

For the Magic and other Blockbuster effects, traditionally animated drawings will be treated as multiple
versions of the same particle type. For example, a traditionally drawn walk cycle appears as a series of
frames on the same layer. Each frame contains a slightly modified version of a character's legs and arms
moving. If this layer were to be used as a sprite, all those different drawings would be randomized and
appear as non-sequential, static, singular particles in the effect. Therefore, if you draw a glitter particle in
the first cell, a different colour glitter particle in the second cell and a different one of another colour in the
third frame, you will obtain a multicolour glitter effect.

15
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You can use this behaviour to your advantage; for example, in the event that you want to create five types
of stars to be multiplied and generated. Simply create five different drawings on the same layer, but
drawing each on their own frame.

3. Drag your newly created Sprite layer onto the Sprite-Drawings layer to parent it. The Blockbuster effect
Sprite (unseen in the Timeline view) is automatically overridden by your custom Sprite.
0 = 5| = &

¥ % Blockbuster-Effect
G _Sprite-Drawings

T

w /- Camera-P
& Camera

Custom sprite with
aseries of particles

If no sprite is created for a Blockbuster effect, the default sprite will be visible.

Shatter Effects

The Shatter effect produces a simulation of a solid pane breaking to pieces in nine various presets:
¢ Wall Destruction: This is the default setting.
¢  Wall Breach: Only a portion of the wall breaks apart.

e Wall Breakthrough: A character shape breaks away from the wall giving the illusion a character ran
through.

¢ Bottle Explosion: A bottle explodes completely breaks apart .
¢ Bottle Break: A bottle breaks apart.

¢ Bottle Fragment: A bottle cracks and breaks.

e Shattered Glass: A glass pane is shattered to pieces.

¢ Broken Glass: A portion of a glass pane is broken to pieces.

¢ Peak-a-glass: A character shape breaks away from the glass pane giving the illusion a character ran
through

To create your own shatter sprite, draw your pane in the first cell of a drawing layer.

16
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In the second cell, draw the pieces in which you want the pane to break apart. The areas where there will not be
any drawing will remain untouched. If you want your pane to break in pieces without leaving a gap between the
pieces, draw your pieces separately.

~ 1
R Ry
000 e

With the Select tool, move them together so that they overlap. If you want to make sure that the outline remains
with the painted zone and that your pieces do not get mixed up, you should group them (outline and colour fill)
together before overlapping your pieces.

M

|
DO Os iy
D‘»DDG

oUD T o

Once your sprite is ready, you can drag your sprite drawing layer onto the Sprite-Drawings layer of your Shatter
Blockbuster effect.

i

17
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The Magic effect produces a simulation of shiny sparkles and particles in nine various presets:
e Glitter Shower: This is the default setting.
e Glitter Mist: A light glitter rain falls down.
e Glitter Fall: A string of glitter falls down as from a fairy or magic wand.
® Ocean Bubbles: Alarge amount of bubbles float up.
¢ SeaBubbles: Aseries of bubbles float up.
¢ Aquarium Bubbles: A few little bubbles float up.
e Omni Star Storm: A series of multicolour stars rush toward the screen.
e Omni Star Mist: A few multicolour stars float toward the screen.

e Omni Star Spin: Stars spin in the scene to similate dizziness.

18
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Explosion Effects

The Explosion effect produces a simulation of smoke and fire explosions in nine various presets:
¢ Blast: This is the default setting.
* Blowup: A big smoke cloud explosion.
* Bang: Asmall cloud explosion.
* Long Electrical Circuit: A long lightning bolt between two electrodes.
¢ Medium Electrical Circuit: A medium lightning bolt between two electrodes.
* Short Electrical Circuit: A short lightning bolt between two electrodes.
e Dazzling Fireworks: A series of multicolour fireworks.
* Brilliant Fireworks: A few multicolour fireworks.

* Glittery Fireworks: One multicolour firework.

Splash Effects

The Splash effect produces a splash of water, goop or mud in nine various presets:
® Water Splash: This is the default setting.
e Water Spray: A medium water splash.
e Water Squirt: A small water splash.

* Goop Splatter: A big goopy splash.

19
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¢ Goop Blob: A medium goopy splash.
* Goop Dab: A small goopy splash.

e Mud Splatter: A big muddy splash.

¢ Mud Blob: A medium muddy splash.
¢ Mud Dab: A small muddy splash.

The Splash effect custom sprite does not work like other Blockbuster effects. The sprite must be a
traditional splash animation.

Fire Effects

The Fire effect produces a simulation of fire and smoke in nine various presets:
¢ Inferno: This is the default setting.
e Fire: Amedium size fire.
e Flame: A small size fire.
¢ Smoke Screen: A big smoke chimney.
¢ Smoke Fog: A medium smoke chimney.
¢ Smoke Cloud: A small smoke chimney.
e Blaze: A huge spark.
¢ Ignite: A medium spark.

e Spark: A small spark.

The Fire effect custom sprite does not work like other Blockbuster effects. The sprite must be a
traditional fire animation.

20
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Celestial Effects

The Celestial effect produces a simulation of space explosions in nine various presets:
e Brilliant Supernova: This is the default setting.
* Bright Supernova: A big and bright supernova explosion.
® Glimmer Supernova: A small and faraway supernova explosion.
¢ Intense White Nova: A gigantic white nova explosion and its large smoke ring.
® Luminous White Nova: A big white nova explosion and its smoke ring.
e Light White Nova: A small white nova explosion and its smoke ring.
e Meteor Storm: Anintense and large meteor shower.
* Meteor Shower: An medium meteor shower.

¢ Meteor Mist: An small meteor shower.

21
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Lip-sync View

The Lip-sync view is where you can create and map mouth charts, as well as import mouth templates for your
characters.

RS

Mouth: |Drawing

Sound: |Sound

(][]

Apply

Advanced Options W

Mapping
N T

To open the Lip-syncview:

1. Select a sound layer from the Timeline view or a cell in the Exposure Sheet view.
2. Do one of the following:

» From the Sound toolbar (Top toolbar on Mac OS X), click the Lip-sync ,‘ button.

» Inthe Properties panel, click the Lip-sync ,‘-"f button.

Creating a Lip-sync Using a Mouth Template

Studio comes with a variety of mouth templates that you can play and experiment with on your characters. You
can create a lip-sync and use an existing sound layer or create the lip-sync and then import the sound.

To create a lip-sync using a mouth template:

1. From the Sound toolbar, click the Lip-sync ,* button (Top toolbar on Mac OS X).

22
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-

Mouth: |Lips [=]= Displays list of drawings

Sand] T Sound L way =] — Displays list of sounds

Do one of the following to add sound:

» Click the Import Sound [ }g) button. From the Open dialog box, select a sound file and click Open.

» From the Sound list, select a sound file you have already imported.

If needed, edit the sound by clicking the Edit Sound s

the Sound Element Editor.

lick the | T I ¢ .
Click the Import Temp atebutton

The template dialog box opens to display the mouth templates.
e )

button and making any adjustments in

N W L — A v

Alien.tbt BigLips.tht BigSmile.tht Boy.tht Cat.tht Clown.tht CrookedTeet...

m

o~ (ﬂ__,:‘_x_j N S=r - —

Demo.tbt Dog.tht Frown.tht Girl.tht RedLips.tbt RoundLips.tbt Smile.tbt

OK ] [ Cancel

%

Select a mouth template and click OK.

In the Timeline view, a Drawing layer is created containing eight mouth drawings.

@0 # = 4 = B =

43 Clown 3 J_LLLLLL“* Eight mouth drawings
oM TB_Sound.wav T W TR

#3 Drawing

= (" CameraP

& Camera R —

In the Lip-Sync view, click Apply to generate the lip-sync with the sound file.

The mouth shapes are synced with the sound file.

“ 0 #= &4 < & 5

45 Clown o | I
o} TB_Sound.wav Ll S i h M e -
43 Drawing

[¥] = ¢ CameraP

& Camera

In the Drawing view, use the Select tool [ N ] in the Animation Tools toolbar to scale the mouth drawings

on the layer.

In the Camera view, place the mouth at the correct location on your character.

23



Toon Boom Studio 8 New Features

Creating a Lip-Sync Using Your Own Drawings

You can use your own drawings to generate a lip-sync.
To create a lip-sync using your own drawings:

1. Inthe Timeline view, select the drawing layer that contains your eight mouth drawings.

2. From the Sound toolbar (Top toolbar on Mac OS X), click the Lip- sync o  button.

The Lip-sync view displays. Your eight mouth drawings are automatically mapped with the animation

=

Mouth: |My Mouth Drawings

] [E]

Sound:
Apply

Advanced Options W

i | Edit Sound...

Mapping

< i
Q‘Kq o s

il B N
- \7_1/ >

\‘E:_v

Wi |

"Jf N

Your eight mouth drawings

j.\r.

3. Do one of the following to add sound:
» Click the Import Sound [ }g) button. From the Open dialog box, select a sound file and click Open.

» From the Sound list, select a sound file you have previously imported.

4. If needed, edit the sound by clicking the Edit Sound et sound-

Sound Element Editor.

button and making any adjustments in the

5. If needed, you can adjust the mouth mapping by clicking the Previous Drawing and Next Drawing arrows
beside any of the mouths.

Mapping

24
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6. Click Apply to generate the lip-sync with the sound file.

The mouth shapes are synced with the sound file.

20 #E 8 B & |

10 20
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M TB_Sound.wav -
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W~ Camera-P
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Working with Scenes and Transitions

In animation, a scene is the action happening in front of the camera while the camera does not change angle. As
long as the camera does not stop "filming" , you are in the same scene. To create scenes in a Studio project, you
will use the Scene Manager where you can select scenes, create and delete scenes, as well as reorder scenes.
When you are satisfied with your scenes, you can add transitions to them.

A transition is a change, like a fade, wipe, or cross dissolve, that you can apply between scenes on the Storyline
view. You can apply transitions to the beginning or end of a single scene, or between two scenes.

About the Storyline View

The Storyline view is where you can manage your scenes, view scenes in a sequence, and add transitions between
scenes.

Timelne [Scene-1] - [Frame 1] X | Exposure Sheet [Scene-1] X | Function Editor X | Storyine b3
] Play Sturyine =t | Il =
o - ] Scene-1
“"Y10 20 30 40 S0 60 70 80 90 100 110 120 130 140 150 160 170 180 190 200 210 220 230 240 250 260 W Somne-2
Scene-1 Fade Scene-2
|
Scene Transition Scene Manager

To access the Storyline view:

1. Do one of the following:
» At the bottom of the Studio screen, click on the Storyline view tab.
» Select Window > Storyline.
» Press[Ctrl] + [Shift] + [M] (Windows) or [&f ] + [Shift] + [M](Mac OS X)
The Storyline view is displayed.

To zoom the Storyline view:

1. Inthe upper-left corner of the scene area, drag the zoom control right zoom in on the scene area. Drag
right to zoom out.

(o} {1
I

Zoom control

Playing a Sequence

A group of scenes occurring in the same location about the same action or event is called a sequence. Once you
have constructed your scenes into a sequences and inserted transitions, you can preview your sequence to see
the result.

To play a sequence:

¢ Inthe Storyline view, click the Play Storyline [ ST button.

26
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Applying Transitions
A transition is a change, like a fade, wipe, or cross dissolve, that you can apply between scenes on the Storyline

view. You can apply transitions to the beginning or end of a single scene, or between two scenes.

For example, you can use a one-sided transition to fade into a scene at the beginning of your sequence. You can
then apply wipes, slides, and cross dissolves between other clips in the Storyline view to move smoothly from
one scene to the next.

The default transition between scenes is fade in and out.

To apply a transition:

1. Inthe Storyline view, select the transition to modify between the scenes. If you removed the existing
transition, select the edit point at the beginning or end of the scene, or between two scenes.

8 S0 100 1o 120 130 140 150" 1'2lsu 170 180 190 200 210 220 230

Scene-1 Fade Scene-2

10 20 30 40 50 60 70 80 90 100 110 120 130 140 150 160 170 iﬁﬁs'lgﬂ 200 210 220 230 240 250 260 ‘

Edit pointat beginning Edit pointbetween scenes Edit point atend of
of sequence sequence

The edit point is highlighted and red playhead snaps to the location you clicked.
2. Inthe Properties panel, select a transition from the Type list. By default, Fade is the default setting.

Type Mo Transition n

Wipe
Slide

Clock Wipe
Chedcker
Cross Dissolve

In the Properties panel, edit the transition properties.

4. Enter the Duration (in frames) for the transition. If you select the Fade transition, you must enter the Left
Duration, Blank Duration, and Duration Right.

5. The transition appears in the Storyline view.

0,00 s,
T0o 20 30 40 S0 60 70 &0 90 100 110 120 130 140 150 160 170 180 190 200 210 220 230 240 250 260
= Scene-1 Fate Scene-2 ipe
Slide transition at Fade transition Wipe transition at
beginning of sequence between scenes end of sequence
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6. Inthe Storyline view, click the Play Storyline button.

To remove a transition:

1. Select a transition.
The transition's properties are displayed in the Properties panel.

2. From the Type list, select No Transition.

Type Clock Wipe

Duration

Angle

Cross Dissolve

Direction |Clockwise |Z|

Transitions

There are six different transitions to choose from in Studio. Once you apply a transition, you can edit its
properties to get just the right look for your project.

e Fade below

¢ Wipe on the facing page

e Slide on the facing page

¢ Clock Wipe on the facing page
e Checker on page 30

¢ Cross Dissolve on page 30

Fade

The Fade transition lets you adjust the video levels to fade in or fade out a clip. You can also specify the colour
from which the scene fades in or to which it fades out.

Fade transition: Scene 1
fades out gradually as
Scene 2 fades in.

Left Duration: The number of frames at the beginning of the transition.
Colour: Opens the colour picker so you can select the colour of the transition.

Blank Duration: The number of blank frames at the end of the transition.
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Wipe

The Wipe effect transition lets you create a transition between two scenes, such that the second clip is revealed
according to a specified pattern.

Wipe transition set to various angles

Wipe set at 0°, Direction = In. Wipe set at 90°, Direction = In.  Wipe set at 180°, Direction = In.
The wipe starts at the top of The wipe starts at the right of  The wipe starts at the bottom of
the frame and moves the frame and moves to the the frame and moves upwards.
downwards. left.

Duration: The number of frames the transition lasts.
Colour: Opens the colour picker so you can select the colour of the transition.
Angle: Let you set the angle at which the transition starts, from 0° to 359°.

Direction: The direction the transition is moving towards: In or Out. In the In direction, the transition moves
towards the left. In the Out direction, the transition moves towards the right.

Slide

The Slide transition lets you show the outgoing scene moving upwards to reveal the incoming scene.

Angle = 45° Angle = 130° Angle = 234°

Duration: The number of frames the transition lasts.
Colour: Opens the colour picker so you can select the colour of the transition.

Angle: Let you set the angle at which the transition starts, from 0° to 359°.

Clock Wipe

The Clock Wipe transition lets you create a wipe transition that moves clockwise or counterclockwise.
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Clock Wipe starts at 180°

Clock Wipe moves in Clock Wipe moves in
clockwise direction. counterclockwise direction.

Duration: The number of frames the transition lasts.
Colour: Opens the colour picker so you can select the colour of the transition.
Angle: Let you set the angle at which the transition starts, from 0° to 359°.

Direction: The direction the transition is moving: Clockwise or Counterclockwise.

Checker

The Checker transition lets you create a transition that resembles a checkerboard. You can change the size and
colour of the checkerboard tiles.

Checker transition with various size tiles

Small tiles Medium size tiles Large tiles

Duration: The number of frames the transition lasts.
Colour: Opens the colour picker so you can select the colour of the transition.

Size: Lets you adjust the size of the checkboard tiles. Drag left for smaller tiles and drag right for larger ones.

Cross Dissolve

The Cross Dissolve transition lets you between scenes in which the image from one scene gradually becomes less
distinct as the image from the other scene replaces it.

Duration: The number of frames the transition lasts.
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